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Getting Started Using UM: Simulating Hybrid Models 

The UM FEM additional module gives the user a possibility to create models of mechanical 

systems that include both rigid and elastic bodies, so called hybrid systems. Elastic displace-

ments assumed to be rather small and describable by finite element method and linear theory. 

This manual helps you to study main features of creating and analyzing hybrid systems using 

Universal Mechanism software. Detailed information about UM FEM you can find in the Chap-

ter 11, file 11_UM_FEM.pdf of UM user’s manual, which is available in the {UM Da-

ta}\MANUAL directory and in the Internet via this link: 

www.universalmechanism.com/download/90/eng/11_um_fem.pdf. 

It is supposed that you already studied the gs_UM.pdf
1
 manual, which is devoted to basics of 

UM modeling and know how to create new model, add new bodies and joints, generate and 

compile equations of motion (UM Input) and simulate mechanical systems (UM Simulation). 

The modal approach is used for simulation of dynamics of elastic bodies. This approach con-

sists in presentation of elastic deformations with the help of a set of eigenmodes and static 

modes
2
 . The approach assumes describing elastic bodies in terms of finite-element method in 

ANSYS software with subsequent export that data to UM. Thus, the necessary condition of us-

ing UM FEM is availability the ANSYS software for some preliminary analysis and calcula-

tions. 

Every elastic body is considered as a separate subsystem. Data file of the elastic subsystem is 

a binary input.fss file. This file may be created with the help of ANSYS_UM.EXE program or 

with the help of Wizard of flexible subsystems in the UM Input. In the latter case AN-

SYS_UM.EXE creates intermediate uminput.fum, that contains input data for the Wizard. 

After ANSYS_UM.EXE creates input.fss or input.fum files the subsequent preparing of the 

model is fulfilled with the help of Universal Mechanism. Since the data files about elastic body 

is exported from the ANSYS software and prepared by ANSYS_UM program ANSYS software 

is not used any more. Complete data flow from ANSYS to UM is shown in the eleventh part of 

UM user’s manual (11_um_fem.pdf). Thus using UM FEM module is possible if ANSYS soft-

ware is available on the user’s computer. 

Note. (1) Before coming to the rest part of the manual please check if the UM FEM 

module is available on your computer. Run UM Input or UM Simulation and 

from the Help menu select About…. The list of available modules is shown in 

the Configuration section. 

                        (2) Please also check if the ANSYS software is available on your computer. If 

you do not have ANSYS on your computer you will have to leave some parts of 

this lesson, where working under ANSYS environment is considered. But never-

theless you will be able to complete the lesson using files prepared in advance. 

                                                           
1
 www.universalmechanism.com/download/90/eng/gs_um.pdf 

2
 Please find more detailed information about static modes and eigenmodes in the eleventh part of UM user’s 

manual (11_um_fem.pdf) 

../11_um_fem.pdf
../11_um_fem.pdf
../11_um_fem.pdf
../../eng
../../eng
http://www.universalmechanism.com/download/90/eng/11_um_fem.pdf
gs_um.pdf
http://www.universalmechanism.com/download/90/eng/gs_um.pdf
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Copyright and trademarks 

This manual is prepared for informational use only, may be revised from time to time. No re-

sponsibility or liability for any errors that may appear in this document is supposed. 

 

Copyright © 2016 Computational Mechanics Ltd. All rights reserved. 

 

All trademarks are the property of their respective owners. 
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1. Slider-crank mechanism 

Here the example model of the slider-crank mechanism (see Figure 1.1) is considered. There 

is Slider_crank_all model in the {UM Data}\SAMPLES\Flex directory. This model includes 

three slider-crank mechanisms. The difference between these models is in the way of representa-

tion of the con-rod. There are following cases: 

 con-rod as a rigid body; 

 con-rod as a system of eleven rigid bodies interconnected by revolution joints with damping 

and elasticity; 

 con-rod as an elastic body according to UM FEM methodology, see Sect. 1.1. 

  

1 

2 3 

4 

 

Figure 1.1. Slider-crank mechanism: 1 – base, 2 – crank, 3 – con-rod, 4 – slider. 

The process of creating and simulating a hybrid model of the slider-crank mechanism with 

elastic con-rod is discussed in this section. 

Preparing the model consists of the following steps: 

1. describing FE model of the con-rod in ANSYS; 

2. calculating elastic modes of the con-rod, saving data in UM format; 

3. creating graphical objects; 

4. describing bodies: crank and slider; 

5. adding elastic con-rod; 

6. creating joints and forces. 

Steps 1-2 are done in under ANSYS environment, 3-6 – in UM. 

Note. UM uses subsystem technique to introduce elastic bodies into the model. Every 

elastic body is represented as a separate subsystem of Linear FEM subsystem 

type. 

Create a directory for the future models, for example {UM Data}\My Models or D:\models. 

Within this section we address this directory as «.\». This directory will include two subdirecto-

ries: 

 flexbeam for an elastic beam data; 

 slider_crank_fem for the hybrid model. 

../../SAMPLES/Flex
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You can read this manual more or less detailed. Please note the following remarks. 

 If ANSYS software is available on your computer and you want to study all the data flow in 

details you should read this manual sequentially. 

 If ANSYS software is not available or you want to omit the step of preparing data in AN-

SYS you can directly start from the Sect. 1.2.2 of this manual. Before that you should copy 

the {UM Data}\SAMPLES\Flex\flexbeam\input.fum to the .\flexbeam directory. 

 You can omit all the steps of elastic body data preparing. Before that you should copy {UM 

Data}\SAMPLES\Flex\flexbeam\input.fss to the .\flexbeam and start reading from the 

Sect. 1.3 of this manual. 

  

../../SAMPLES/Flex/flexbeam/input.fum
../../SAMPLES/Flex/flexbeam/input.fss
../../SAMPLES/Flex/flexbeam/input.fss
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1.1. Preparing ANSYS environment 

We will use ANSYS software for preparing data for simulation of dynamics of elastic body. 

After creating FE model a calculation of the static and eigenmodes starts. Macro um.mac is used 

for such a calculation. Then ANSYS_UM program starts. This program translates data, that are 

produced by um.mac into UM format. 

Copy the um.mac file from {UM}\bin to ANSYS default directory for macros. It is usually 

the .\docu directory in ANSYS 5.0, .\apdl in ANSYS 7.0 9.0 root directory. Otherwise you need 

to set search path with the ANSYS command 

/PSEARCH,Path_to_macro 

After preparing data the um.mac macros runs the external ansys_um.exe program for subse-

quent analysis of obtained data. The ansys_um.exe is situated in the {UM}\bin directory. You 

need to open the um.mac in any text editor and edit the path to the ansys_um.exe program in the 

last line of the macros. Set full path to the ansys_um.exe as the parameter of the /sys command. 

For example, 

/sys,c:\um\bin\ansys_um.exe 

Note 1. If the full path to the ansys_um.exe program contains space(s) then use inverted 

commas. For example, /sys,”c:\universal mechanism\bin\ansys_um.exe” 

Note 2. Path to the ansys_um.exe program should contain the Latin letters only. 
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1.2. Preparing con-rod as an elastic beam 

As it mentioned above, preparing data for introducing elastic bodies into hybrid models con-

tains the stage of solution of eigenvalues problem. There are two possible mathematical formula-

tions of this problem: 

 with diagonal mass matrix; 

 with consistent mass matrix. 

The {UM Data}\SAMPLES\Flex\flexbeam\input directory contains two subdirectories: 

lumped and consistent. The first one includes an ANSYS command file for the case of diagonal 

mass matrix, the second one – for consistent mass matrix.  

In the manual we will consider the case with diagonal mass matrix. 

1.2.1. Working under ANSYS environment 

1. Copy the flexbeam&mass21.ans file from the {UM Da-

ta}\SAMPLES\Flex\flexbeam\input\lumped directory to the .\flexbeam directory. This file 

is the ANSYS command file, uses APDL language and describes the process of ANSYS 

model creation. This file also contains comments that explain every step of the process. 

2. Run ANSYS Interactive and select the .\flexbeam directory as working directory and set 

Working directory to .\flexbeam, for example d:\models\flexbeam. 

3. Run ANSYS. From the File menu select Read Input from and choose 

.\flexbeam&mass21.ans. Steel beam of 2 m length and square cross section with 2 cm 

width is created. Finite element model consists of 100 elements of BEAM4 type and 200 el-

ements of MASS21 type. Two end nodes are automatically selected as interface nodes
1
. If 

you made all setting ANSYS environment correctly then the um.mac macros is started au-

tomatically and calculates 12 static modes and 10 eigenmodes of the beam. 

4. If you changed path to the ansys_um.exe program in um.mac properly then um.mac runs 

ansys_um.exe automatically. Otherwise run the {UM}\bin\ansys_um.exe manually. The 

main window of ansys_um appears, Figure 1.2. 

5. Point to the General tab. The ANSYS results file (*.rst) set to .\flexbeam\flexbeam.rst, 

Target directory set to .\flexbeam, see Figure 1.2. 

                                                           
1
 More detailed information about interface nodes you can find in the eleventh part of UM User’s Manual 

../../SAMPLES/Flex/flexbeam/input
../../SAMPLES/Flex/flexbeam/input/lumped
../../SAMPLES/Flex/flexbeam/input/lumped
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Figure 1.2. Main window of the ANSYS_UM program. 

6. Point to the Options tab and turn off the normalize modes check box, Figure 1.3. This case 

corresponds to creating the intermediate input.fum file. On the successive step we will use 

the Wizard of flexible subsystems to convert the data into UM-compatible form. 

 

Figure 1.3. 

Note. Using the Wizard of flexible subsystems is not necessary step of the creation of 

the model. However it seems to be very important for your understanding UM 

that you go through the Wizard. 

                        It possible to prepare all necessary data with the help of ANSYS_UM program 

only. To do this you should turn on modes normalize and exclude rigid body 

modes check boxes and set frequency. In this case the input.fss file will be creat-

ed. Please read eleventh part of UM User’s Manual for more detailed infor-

mation. 

7. Click the Create button. Calculations will take some time. The .\flexbeam\input.fum file 

will be created as a result.  

8. Click the Close button. 
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1.2.2. Wizard of flexible subsystems 

During the next step we will use the wizard of flexible subsystems data. It is a tool for anima-

tion of elastic modes, and exclusion of some of them. 

Note. Using the wizard of flexible subsystems data is not an obligatory phase. Prepar-

ing the data can be fulfilled with the help of ansys_um program. To do this point 

to the Options tab and turn on the normalize modes and exclude rigid body 

modes check boxes and set frequency value, Figure 1.3. Nevertheless now we 

will use the wizard of flexible subsystem data in order to familiarize you with it. 

The intermediate input.fum file contains static modes and eigenmodes. To finish preparing 

data it is necessary to orthogonalize modes. It may be done directly in the ansys_um program 

and if necessary with the help of wizard of flexible subsystems data. 

1. Run UM Input program (uminput.exe).  

2. Click the Tools | Wizard of flexible subsystems menu item. The main window of the wiz-

ard of flexible subsystems data appears. 

3. Click the  and select a file for the Data file, Figure 1.4, Figure 1.5. 

 

Figure 1.4. 

Wizard loads and shows the data, Figure 1.6. The General tab shows summary information 

about elastic subsystem, see Figure 1.6. 

The Position tab (see Figure 1.7) is used for setting position and orientation of the elastic 

body. These transformations influence on the representation of the elastic body in the animation 

window of the wizard. Flexible body in the starting position coincides with X-axis that is not re-

ally comfortable to watch. Now we will shift the beam along Z axis with 0.3 m. 

4. Point to the Position tab. 

5. Set Shift | z to 0.3, see Figure 1.7. 
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Figure 1.5. 

 

Figure 1.6. 
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Figure 1.7. 

Using the Image tab we can change graphical representation of the FE model. There are two 

modes of such a representation: simplified and full. During the full model status line shows the 

information about nodes and finite elements when mouse cursor is on it. However the full mode 

takes more CPU time to animate. 

6. Set Image to full. 

7. Turn off the Image parameters | Draw nodes check box. 

8. Set the rest parameters according to the Figure 1.8. 
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Figure 1.8. 

Note. Single node finite elements of the MASS21 type are used for setting moment of 

inertia of the body relative to the longitudinal axis. Set Sizes | Single node FE to 

0 in order to hide such elements and make the image clearer. 

The Solution tab gives you a possibility to animate modes of elastic subsystem. To start an-

imation you should click the Animate button, see Figure 1.9. You can control this animation 

with the help of Amplitude and Rate track bars. 

You can include/exclude any form from the final set of modes turning on/off the correspond-

ing check boxes in the Modes tab. The more modes you include in the final solution and the 

more frequency these modes have the more accurate and time-consuming subsequent numerical 

integration you have. Generally it is recommended to turn on/off modes to keep a balance be-

tween solution accuracy and time efforts for it. 

Thus, you can fulfill the only calculation in the ANSYS software with the maximum modes 

you will ever use (10 in this example) and then form various sets of modes with the help of the 

Wizard of flexible subsystems data. 

Leave the initial set of modes without any changes. 
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Figure 1.9. 

9. Turn on the Transformations | Exclude rigid body modes (Figure 1.9). 

10. Set Transformations | Frequency to 0.3 (Figure 1.9). 

11. Click the Transform button and confirm this action in the subsequent dialog. 

As a result the transformed set of modes of elastic body is created. In the case of successful 

execution of the transformation the following message appears, see Figure 1.10. 
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Figure 1.10. 

Note. The initial set of modes includes rigid body modes, which should be excluded 

according to the used approach for simulation. Rigid body modes theoretically 

correspond to zero frequencies, but in fact because of using numerical methods 

and round-off errors these frequencies are small and close to zero but not exact 

zero. 

                        In fact the Transformations | Frequency field indicates the threshold value and 

all frequencies that are less than this value are supposed to correspond to rigid 

body modes. 

Now we need to save the transformed data set. 

12. Point to Transformed in the Data set group, Figure 1.11. 

 

Figure 1.11. 

13. Click the Save as button. In the dialog set Path to subsystem data and click the Save but-

ton, see Figure 1.12. Please, note, that the latter directory will further serve as a subsystem 

name. 

 

Figure 1.12. 

Preparing the data for flexible subsystem is done. 
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1.3. Creating the model 

The hybrid model of the slider-crank mechanism includes two rigid bodies, one elastic body 

and four joints. 

Bodies: 

 crank, 1 m length; 

 con-rod, 2 m length; 

 slider. 

The crank and the slider are rigid bodies, con-rod is elastic subsystem (in terms of UM). 

Joints: 

 revolution joint between Base0 and the crank, crank and the con-rod, and the con-rod and 

the slider; 

 translational joint between slider and Base0. 

1. Create a new model. Point the File | New object menu command or click the   button. New 

constructor window appears. 
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1.3.1. Creating graphical objects 

1. Load a graphical object from the {UM Data}\graph\Base1.umi file using  button or Ed-

it | Read from file… menu item. Element «NoName» will be added to the list of graphic el-

ements, see Figure 1.13. 

 

Figure 1.13. 

2. Select this element and set name to Base0 in the data inspector (Figure 1.14). 

 

Figure 1.14. 

3. Repeat these actions for Crank1.umi and Slider1.umi files, which are located in the direc-

tory {UM Data}\graph. Set the names Crank and Slider to created graphical objects corre-

spondently.  

Thus, three graphical objects are created. 

 

Figure 1.15. 

4. Select Object item in the tree of elements and set Scene image to Base0, see Figure 1.16. 
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Figure 1.16. 
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1.3.2. Creating rigid bodies 

Here we create slider and crack as rigid bodies, set graphical objects for them and set their 

inertia parameters. 

1. Select Bodies in the tree of elements. 

2. Add two new bodies. 

3. Rename bodies with Slider and Crank and set the correspondent graphical objects (Slider 

and Crank). 

4. Select the Parameters tab and turn on the Compute automatic flag for the both of bodies. 

Inertia property of the bodies are computed automatically, see Figure 1.17. 

 

Figure 1.17. 

  



Universal Mechanism 10 20 Getting Started: UM FEM 

 

1.3.3. Creating elastic subsystem 

Now we introduce the elastic con-rod in the model. Every elastic body within a hybrid model 

is represented as elastic subsystem. 

1. Select the Subsystems item of the tree of elements and create new subsystem using the  

button. 

2. In the Type select «Linear FEM subsystem» and choose the .\flexbeam directory in the 

open dialog window. 

3. Set Name to Con-rod FEM (Figure 1.18). 

After reading elastic subsystem data inspector looks like the wizard of flexible subsystem da-

ta described in the Sect. 2.1.4. There are following differences between wizard of flexible sub-

system and the window of elastic subsystem data. 

 You cannot changes set of modes in the window of elastic subsystem data since all data is 

already prepared. 

 The Position tab influences to the real position and orientation of the elastic body in con-

trast to wizard of flexible subsystem where Position tab influences on the graphical repre-

sentation of the body. 

Elastic modes of the subsystem you can see using the Solution | Modes tab. 

 

Figure 1.18. 
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1.3.4. Creating joints 

Let’s create the first joint – revolution joint between Base0 and the crank. 

1. Select Joints item of the tree of elements. Add new joint. 

2. Rename the joint to jBase0_Crank. Select Rotational type for the joint and set Y axis as 

Joint vectors, see Figure 1.19. 

 

Figure 1.19. 
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3. Select the Joint force tab, set Joint torque to Expression and in the field Description of force 

set F= torque-cdiss_crank*v, see Figure 1.20. Press Enter. The window Initialization of 

values for new identifiers appears. Set identifiers value as follows: torque = 100, 

cdiss_crank = 10. 

 

Figure 1.20. 

4. Add the rest three joints as it is shown in the figure 1.21. 

 

Figure 1.21. 
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1.3.5. Preparing for simulation 

1. Save the model as Slider_crank_fem (File | Save as… menu command), see Figure 1.22. 

 

Figure 1.22. 

2. Please check that numeric-iterative method of generation of equations is selected (see 

Object | General tab). 

 

Now the model is ready for simulation. 
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1.4. Simulation 

1. Use the menu command Object | Simulation… to run UM Simulation program. Main 

window of the UM Simulation program appears. 

 

Let’s obtain reaction forces in the joints jCrank_Con-rod and jCon-rod_Slider. 

 

2. Open new animation window. 

3. From the Analysis menu select Simulation. Object simulation inspector appears. Select 

the FEM subsystems | Image tab to set up animation parameters of the elastic con-rod as 

you want. 

 

Now we will calculate initial conditions. 

 

4. In the Object simulation inspector select the Initial conditions tab. Select the Con-rod 

subsystem in the drop down list, Figure 1.23. An anchor sign means that the correspondent 

degree of freedom is frozen. In this example it means that the elastic degrees of freedom 

will not be changed during calculation of initial position. 

Note. If the Initial condition tab differs to the Figure 1.23 set the anchors manually. 

5. Make sure that the Autocalculation of constraint equations mode is turned on (the  

button should be pressed), otherwise press this button. Then calculate the initial conditions 

by clicking the  button. Animation window shows the current position of the mecha-

nism, Figure 1.24. 
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Figure 1.23. 

 

Figure 1.24. 

6. Open new graphical window (Tools | Graphical window menu command). 

7. Run Wizard of variables and create variables to determine absolute values of reaction forc-

es in joints jCrank_Con-rod jCon-rod_Slider (Figure 1.25) and drag them to the graphical 

window. 
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Figure 1.25. 

8. Select the Object simulation inspector and point to the Solver tab. Set the following pa-

rameters: 

 Solver = Park, 

 Type of solving = Range Space Method, 

 Simulation time = 2.0. 

 Step size for animation and data storage = 0.001. 

 Error tolerance = 1E-7. 

 Computing Jacobian matrices = on (always default). 

 Block-diagonal matrices = off. 

 

Figure 1.26. 
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9. Select the FEM Subsystems | Simulation tab and set up all options according to Fig-

ure 1.27. 

 

Figure 1.27. 

10. Start simulation (Integration button).  

You can see movement of the mechanism in the animation window (see Figure 1.28) and os-

cillograms of reaction forces in the graphical window (see Figure 1.29). 

 

Figure 1.28. Animation window 
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Figure 1.29. Graphical window 

In order to estimate the influence of the elastic con-rod instead rigid one, open the {UM Da-

ta}\SAMPLES\Flex\Slider_crank_all model. Graphs of the reaction force are shown in the Fig-

ure 1.30. 

 

1 2 

 

Figure 1.30. Reaction force in the Con-rod _Slider joint 1 – con-rod is a rigid body, 2 – con-rod 

is an elastic body. 

../../SAMPLES/Flex/slider_crank_all
../../SAMPLES/Flex/slider_crank_all
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Configuration file example.icf, which is situated in the Slider_crank_all directory, contains 

graphical windows with reaction forces in the rest joints of the model, as well as angular veloci-

ties of all cranks. 
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2. Electric motor on elastic platform 

Let us consider step by step dynamical analysis of a mechanical system that consists of an 

electric motor and an elastic platform, Figure 2.1. 

 

 

Figure 2.1. 

The elastic platform is connected to a ground with the help of four visco-elastic linear force 

elements. The electric motor is included to a model as an external subsystem and is also connect-

ed with the help of four visco-elastic linear force elements, Figure 2.1. An eccentric is attached 

to a rotor of the electric motor. This eccentric produces forced oscillations of the platform. 

Basic features of the description of the model and its dynamical analysis is considered in this 

section. 

During the simulation we will analyze the following dynamical properties of the system:  

 forces in the force elements; 

 vertical displacements and accelerations of the platform in the center part under the motor. 

Here we will simulate the following sequence of operation modes: 

 running of the rotor from ω=0 up to its nominal angular velocity. 

 operating duty; 

 stop way – decreasing angular velocity of a rotor till ω=0. 

Preparing the model includes the following steps: 

 preparing data of the elastic platform; 

 introducing FE model of the platform into the final UM-model; 

 attaching the elastic platform to a ground; 

 creating the model of the electric motor; 

 introducing the electric motor into the final model as an external subsystem; 

 attaching the electric motor to the platform with the help of visco-elastic elements. 

Let us consider all of the described above steps in details. At that main attention will be put 

to the features that were not considered in the previous section.   
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It supposes that you already finished the previous section that is why some comments here 

are given shortly. 

Please choose an existing or create a new directory for the future model. Within this section 

we will address this directory as «.\». Create two subdirectories: 

 .\Vibrostand for the final composite model; 

 .\Vibrostand\Platform for elastic platform. 
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2.1. Preparing elastic platform 

In terms of Universal Mechanism software every elastic body is considered as a separate sub-

system of Linear FEM subsystem type. Standard save file for such a subsystem is input.fss 

file. Preparing the elastic platform includes the following steps: 

1. description the FE model of the platform in ANSYS software; 

2. calculation of the elastic modes and export result from ANSYS in UM format. 

There are two possible ways to fulfill the second step: 

3. generate the input.fss file directly by ANSYS_UM.EXE program; 

4. firstly generate the intermediate input.fum file by the ANSYS_UM.EXE and then com-

plete data transformations with the help of Wizard of flexible subsystems that is a tool 

within the UM Input program. This wizard gives the user a possibility to visualize calculat-

ed elastic forms and exclude some modes from the final set of elastic modes (input.fss). 

There are three files in the {UM Data}\SAMPLES\Flex\platform: input.fss, input.fum and 

platformshell63.ans.  

 If you want to omit the step of preparing the data in ANSYS but familiarize yourself with 

Wizard of flexible subsystems you should copy the {UM Data}\Samples\Flex\input.fum 

file to the .\platform directory and go to the Sect. 2.1.4 of this manual. 

 You may omit all the steps of creating the data of elastic platform, in this case you should 

copy the {UM Data}\SAMPLES\Flex\platform\input.fss file to the .\platform directory and 

go to the Sect. 2.1.4 of this manual. 

  

../../SAMPLES/Flex/Platform
../../SAMPLES/Flex/Platform/input.fss
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2.1.1. Working under ANSYS environment 

Before you come to the next step please repeat all the steps from the Sect. 1.1. 

Now we will create the FE model of the platform and export the data for the subsequent us-

ing them under UM environment. 

5. Copy the platformshell63.ans file from the {UM Data}\SAMPLES\Flex\platform directory 

to the .\platform directory. This file contains APDL commands that automatize creating the 

FE model of the platform. 

6. Run ANSYS Interactive and select the .\platform directory as a working directory. 

7. Run ANSYS.  

8. From the File menu select the Read Input from and open the platformshell63.ans file. As 

a result a steel platform that is consists of two beams of 1m length and a shelf between 

them.  

This finite-element model includes 4224 elements of SHELL63 type. Width of all elements is 

5 cm. You can open platformshell63.ans in any text editor and change some of parameters of 

the FE model, see comments in the body of this file. Four nodes, where the platform is connected 

with the ground, are selected as interfaced nodes. In the end the um.mac is run. If the um.mac is 

not run automatically you should run it manually, see Sect. 1.1. As a result of the um.mac exe-

cution 24 static modes and 10 eigenmodes are calculated. 

9. If the path to the ANSYS_UM.EXE in the um.mac is set correctly (see Sect. 1.1), AN-

SYS_UM.EXE starts automatically. Otherwise run ANSYS_UM.EXE manually from the 

{UM}\bin directory.  

10. Transform data according the 5-8 items of the Sect. 1.2.1. 

  

../../SAMPLES/Flex/Platform
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2.1.2. Working under ANSYS Workbench environment  

Run a PlatformShell63Demo.ans macro in APDL language to create a FE-model of a plat-

form for a vibrostand in a classic ANSYS (Mechanical APDL) program. In a Workbench envi-

ronment it is impossible to perform such a macro that is why to create a model of platform in 

ANSYS Workbench you should take the following steps. 

11. Create a model in ANSYS Mechanical APDL (see Sect. 1.2.1. "Working under ANSYS en-

vironment", p. 8). Before running the PlatformShell63Demo.ans macro, delete all the 

commands intended for import in the UM software: 

NSEL,s,,,ALL 

ESLN,s,0,ALL 

CM,ESTRS,ELEM 

ESEL,ALL 

NSEL,ALL 

KSEL,S,,,5 

KSEL,A,,,11 

KSEL,A,,,105 

KSEL,A,,,111 

NSLK,S 

UM,10,1,1,1 

 

Save changes. Run the changed macro using File->Read Input From commands. Create a 

file with the Preprocessor -> Archive Model -> Write archive. In the appeared Write Geome-

try/Loads for Archiving window choose the view of the archived information and a name of the 

file with the archive, Figure 2.2. 

 

Figure 2.2. Creating an archive of a platform model 
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12. In the ANSYS Workbench environment on the taskbar in the Component Systems section 

choose Finite Element Modeler by double-clicking on it. 

 

An empty object will appear in Finite Element Modeler in the Project Schematic window. 

Right-click on the Model->Add Input Mesh->Browse menu item. Choose a file with .cdb ex-

tension, created in the previous step, Figure 2.3. Refresh the model, right-click in the Model 

field then choose the Update in the dropdown list. 

 

13. Choose a Model field of the scheme project then choose the name of the imported file 

(Platform.cdb) and choose SI system in the Unit System properties field, see Figure 2.4. 

 

Figure 2.3. 

 

Figure 2.4. Choosing SI system   
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14. Create a project of modal analysis by double-clicking on a Modal component in the taskbar, 

Figure 2.5. 

 

Figure 2.5. 

15. Drag the Model field of a project in Finite Element Modeler on the Model field of modal 

analysis, created in the previous step, Figure 2.6. 

 

Figure 2.6. 

Refresh the model in the project of modal analysis. Right-click on the Model field and 

choose Update in the dropdown list. Click File->Save to save the project. 

16. Open the Modal project model by double-clicking on the Model field. The Mechanical 

module will be run, see Figure 2.7. 

17. Add the Commands field in the project tree Modal->Insert->Commands. Set the com-

mands in APDL language. For the downloaded model it is recommended to use the follow-

ing commands: 

NSEL,s,,,ALL 

ESLN,s,0,ALL 

CM,ESTRS,ELEM 

ESEL,ALL 

NSEL,ALL 

NSEL,s,,,2435 

NSEL,A,,,730 
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NSEL,A,,,2659 

NSEL,A,,,958 

UM,10,1,1,1 

In these commands 2435, 730, 2659 and 958 are the numbers of the interface nodes, situated 

in the points with numbers 5, 11, 105 and 111, position of which is set in the Plat-

formShell63Demo.ans file. If the parameters of FE-mesh were changed, the numbers of the in-

terface nodes can be different too. 

There is more information about APDL language commands in the Chapter 11, which you 

can download using the following link: 

www.universalmechanism.com/download/90/eng/11_um_fem.pdf. 

 

Figure 2.7. Mechanical module window with the model of platform 

18. Run the solution process Solution->Solve. As a result the .rst, .free solution files will be 

situated in the folder of a PROJECT_NAME\dp0\SYS\MECH working project. 

19. Run ANSYS_UM.exe, choose a file with .rst extension, create the input.fum file. 

  

file://///umstorage2/public/Projects/UM%20Manual/eng/11_um_fem.pdf
http://www.universalmechanism.com/download/90/eng/11_um_fem.pdf
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2.1.3. Preparing elastic platform data in FIDESYS software 

In the UM program, each elastic body corresponds to a Linear FEM subsystem . The data file 

of the elastic subsystem is a binary file input.fss. Preparation of elastic platform data includes 

several steps described below: description of the platform by the finite element method in the 

FIDESYS program and creation of files for the import in the UM software; creation of an in-

termediate input.fum file with the FIDESYS_UM.exe program and the subsequent data trans-

formation using the Master of data preparation of elastic subsystems, which is an integral part 

of the UM Input program. It provides the ability to view the calculated elastic forms of the sub-

system, as well as exclude some forms from the resulting data set stored in the input.fss file. 

The finite element model (FE model) prepared in the FIDESYS software is stored in a file 

with the .fds extension. The data on the FE model prepared using the FIDESYS program for im-

port into the UM software are contained in the geometry.vtk files (contains data on the geome-

try of the object, the FE mesh), res.cbm (native and static forms), M_CCS.hb (mass matrix), 

K_CCS.hb (stiffness matrix). 

The geometry.vtk, res.cbm, M_CCS.hb, K_CCS files are located in the {UM Da-

ta}\SAMPLES\Flex\vibrostand\platform directory, they are created to import data into the 

UM software, and the platform.fds file, containing all the information about the platform's 

FE model in the FIDESYS software, which should be used depending on the completeness of 

the study of this manual. 

If the user wants to skip the stages of development and preparation of the FE model in the 

FIDESYS software, you can use the ready-made gеometry.vtk, res.cbm, M_CCS.hb, 

K_CCS.hb files and go to Sect. 2.1.3.4. 

The steps of creating a FE model in the FIDESYS program interface are presented in 2.1.3.1, 

the method of creating this FE model on the basis of FIDESYS software commands is shown in 

2.1.3.2. 

If the user wants to skip the steps of creating a FE model in the FIDESYS software, you can 

use the ready-made platform.fds file, which contains information about the FE model and inter-

face nodes. In this case, you can go straight to Sect.2.1.3.3. 

  

file:///C:/Users/Krugovova/AppData/Roaming/SAMPLES/Flex/Vibrostand/platform
file:///C:/Users/Krugovova/AppData/Roaming/SAMPLES/Flex/Vibrostand/platform
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2.1.3.1. Working in the FIDESYS program interface 

In the FIDESYS program, we will create a model of a steel platform consisting of two 

beams 1 m long, having an I-beam section, and a shelf that connects these beams. The width of 

the upper and lower shelves of the beam sections is 10 cm, the height of the sections is 6 cm. The 

length and width of the connecting shelf is 40 cm. 

We will create the geometry of the model based on the plates. There are several options for 

creating planes in the FIDESYS program, for more information, see the user manual on the pro-

gram's website
1
. In this manual, one of the ways is considered - the creation of a plane based on 

vertices. Select on the command panel Mode - Geometry, Entity - Vertex, set Coordinates in 

the drop-down list, enter the x, y, z coordinates of the four vertices of the future surface ([ 0.5; 

0.3;0.06], [ 0.5; 0.25;0.06], [0.5; 0.25;0.06], [0.5; 0.3;0.06]), click Apply (Figure 2.8). 

  

Figure 2.8 

As a result, 4 points will appear in the animation window. Then select Entity - Surface, Ac-

tion - Create, in the drop-down list - Vertex ID(s), enter 4 vertices, click Apply (Figure 2.9). As 

a result, the first surface is created. 

                                                           
1
 https://cae-fidesys.com/documentation/ 
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Figure 2.9 

By entering the coordinates of two more vertices [-0.5;-0.25;0] and [0.5;-0.25;0], we will 

create surface 2 (Figure 2.10). 

 

Figure 2.10 

Using the method described above, you can create all the surfaces of the model, and to sim-

plify the work, you can use copying, rotating and moving an already created surface (Figure 

2.11). Create a surface 3 by copying with moving along the Z axis by -0.06 m of surface 1 

(Mode - Geometry, Entity - Surface, Action - Create, Copy and Transform, Move, in the z 

coordinates field we specify z = -0.06), and the surface 4 by copying with rotation around the 

curve 2 by 180 degrees of the surface 1, the surface 5 by copying with the movement of the sur-

face 4 (Figure 2.12). 

surface 1 

surface 2 

surface 1 
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Figure 2.11 

  

Figure 2.12. Creating a surface by copying and moving  

At this stage, one of the two beams of the I-beam section has been obtained. Let's create a 

second beam (Figure 2.13) by copying the surfaces 1, 2, 3, 4, 5 of the first beam along the Y axis 

by 0.5 m (Mode - Geometry, Entity - Surface, Action - Create, Copy and Transform, Move, 

in the coordinates field we specify y = 0.5). 

surface 2 

surface 1 

surface 3 

surface 4 

surface 5 

curve 2 
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Figure 2.13  

Let's create the middle surface of the platform by its 4 vertices (Figure 2.13). Select Mode - 

Geometry, Entity - Vertex, Action - Create, set Coordinates in the drop-down list, enter the x, 

y, z coordinates of each vertex of the future surface ([-0.2;-0.2;0.06], [0.2;-0.2;0.06], 

[0.2;0.2;0.06], [-0.2;0.2;0.06]), click Apply. Then select Entity - Surface, Action - Create, in 

the drop-down list - Vertex list, enter 4 created vertices (Figure 2.14). 

 

Figure 2.14 

To get the desired mesh, combine several surfaces into one. To do this, select Mode - Geom-

etry, Entity - Surface, Action - Boolean on the command panel, select Unite, specify the num-

bers of the middle surface of the platform (11) and two neighboring surfaces (6 and 4), click 

Apply (Figure 2.15). 
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Figure 2.15 

The result of the merge will be a surface 4 (Figure 2.16). 

 

Figure 2.16 

To exclude duplicated curves from the geometric model, the presence of which is caused by 

copying planes, combine the repeating curves Mode - Geometry, Entity - Curve, Action - 

Merge, in the Curve ID(s) field, type all, click Apply (Figure 2.17). The geometric model is 

ready. 

 

Figure 2.17 
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Let's create a material named Steel. On the command panel, select Mode - Material, object - 

Material Management. Let's give it the Young's modulus properties 2e11 Pa, Poisson ratio 

0.3, Density 7850 kg/m3. Click Apply, the created material with the name Steel (Figure 2.18) 

should appear in the list of materials. 

 

Figure 2.18 

Creating a block with the inclusion of all created surfaces in it, select Mode -Blocks, Entity - 

Block, Action - Add, select Surface from the list of entities, type all (Figure 2.19) in the Entity 

ID(s) field. 

 

Figure 2.19 

Now you need to assign shell properties to the created block (Figure 2.20). Select Mode -

Blocks, Entity - Block, Action - Block properties/parameters, select the created block, Cate-

gory - Sell, Order 1, click Set Shell Properties (Figure 2.20 on the left). In the appeared win-

dow Set Shell Properties (Figure 2.20 on the right), enter Thickness 0.005 m and select the 

Steel material, click Apply. Then click Apply in the window for setting block properties (Figure 

2.20 on the left). 
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Figure 2.20 

Let's set the grid construction scheme. When creating a finite element scheme of the plat-

form, nodes are provided at the attachment points of the force elements, through which the elec-

tric motor is located. In order to get the desired FE grid, we determine the size of the finite ele-

ment by specifying the number of elements for each curve (Figure 2.21). 

 

 

Figure 2.21 

80 FE 
24 FE 

4 FE 
32 FE 24 FE 

32 FE 

24 FE 

24 FE 

4 КЭ 

4 КЭ 

4 КЭ 

4 КЭ 
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Select Mode - Mesh, Entity - Curve, Action - Mesh, put the cursor in the Select Curves 

field, then select the desired curves in the graphical window, select Equal in the drop-down list, 

set Approximate Size, enter the desired number of partitions in the Approximate Size field 

(Figure 2.22 - Figure 2.25). 

 

Figure 2.22 

 

Figure 2.23 
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Figure 2.24 

 

Figure 2.25 

To create a surface FE grid with the specified scheme, select Mode -Mesh, Entity - Surface, 

Action - Mesh, select 4 meshing scheme SubMap for the combined surface, click Apply 

Scheme, Mesh, for the remaining surfaces (1, 2, 3, 5, 7, 8, 9, 10) choose the meshing scheme 

Map, then click Apply Scheme, Mesh. (Figure 2.26). 
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Figure 2.26 

As a result, we obtain a finite element model including 4224 elements of the SHELL type, 

the thickness of all elements is 5 mm. 

4 nodes are selected as interface nodes at the points of attachment of the platform to the base. 

The definition of the idea and description of the purpose of interface nodes are given in Chapter 

11 of the UM User Manual (11_UM_FEM.pdf). Create a set of interface nodes Mode - Manage 

Set, Entity - Nodeset, Action - Create nodeset, enter NodesetName, select interface nodes 

(Figure 2.27). 

file:///C:/Users/Krugovova/AppData/Roaming/Microsoft/11_um_fem.pdf
file:///C:/Users/Krugovova/AppData/Roaming/Microsoft/11_um_fem.pdf
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Figure 2.27 

Finite element model of the platform is ready. 

2.1.3.2. Working in the FIDESYS software using command-line commands 

The operation of the FIDESYS program is also controlled by entering commands in the 

command line (Figure 2.28). 

 

Figure 2.28 

Thus, all the actions described in 2.1.3.1 can be performed by a set of commands. Below 

there is a list of commands that specify the creation of a finite element model of the platform 

with interface nodes. If you want to quickly create a platform model, copy and paste the follow-

ing commands into the command line window (you can copy and paste all the lines at once).  

create vertex -0.5 -0.3 0.06  

create vertex -0.5 -0.25 0.06  

create vertex 0.5 -0.25 0.06  

create vertex 0.5 -0.3 0.06  

create surface vertex 1 2 3 4  

create vertex -0.5 -0.25 0  

create vertex 0.5 -0.25 0 

create surface vertex 5 2 3 6  

Surface 1 copy move z -0.06  

Surface 1 copy rotate 180 about vertex 2 3 nomesh  

Surface 4 copy move z -0.06 nomesh  
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Surface 1 2 3 4 5 copy move y 0.5 nomesh  

create vertex -0.2 -0.2 0.06  

create vertex 0.2 -0.2 0.06  

create vertex 0.2 0.2 0.06  

create vertex -0.2 0.2 0.06  

create surface vertex 41 42 43 44  

unite surface 4 11 6 

merge curve all  

create material 1 

modify material 1 name 'Steel' 

modify material 1 set property 'MODULUS' value 2e+11 

modify material 1 set property 'POISSON' value 0.3 

modify material 1 set property 'DENSITY' value 7850 

set duplicate block elements off 

block 1 add surface all 

create shell properties 1 

modify shell properties 1 layer count 1 

modify shell properties 1 layer 1 thickness 0.005 

modify shell properties 1 layer 1 material 1 

modify shell properties 1 layer 1 angle 0 

modify shell properties 1 layer 1 cs 1 

modify shell properties 1 eccentricity 0.5 

modify shell properties 1 layer direction normal 

modify shell properties 1 thickness_change on 

block 'Block 1' element shell order 1 

block 'Block 1' shell properties 1 

curve 46 47 48 45 interval 24 

curve 46 47 48 45 scheme equal 

curve 2 22 32 12 4 36 40 28 8 20 interval 80 

curve 2 22 32 12 4 36 40 28 8 20 scheme equal 

curve 42 44 interval 32 

curve 42 44 scheme equal 

curve 13 1 17 21 33 37 25 29 9 5 11 19 7 3 15 23 35 39 27 31 interval 4 

curve 13 1 17 21 33 37 25 29 9 5 11 19 7 3 15 23 35 39 27 31 scheme equal 

surface 4 submap smooth off 

surface 4 scheme submap 

mesh surface 4  

surface 9 10 2 5 1 7 8 3 scheme map 

surface 9 10 2 5 1 7 8 3 scheme map 

mesh surface 9 10 2 5 1 7 8 3 

nodeset 1 add vertex 28 6 25 5 

nodeset 1 name "InterfaceNodes" 

As a result of executing the commands, a finite element model of the platform with interface 

nodes will be created, which can be prepared for import, according to 2.1.3.3.  

 

2.1.3.3. Preparing the model for import into the UM software. 

To prepare a model for import click Mode - Calculation Settings, Calculation Settings - 

External Integration MBD, choose Number of eigenmodes - 10, set OutputFormat - Binary, 

нажимаем Apply, then Start Calculation (Figure 2.29). 
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Figure 2.29 

Specify the path to save the task (Figure 2.30). 

 

Figure 2.30 

After the calculation is completed, files with the results will be received with the resuts: ge-

ometry.vtk, res.cbm, M_CCS.hb, K_CCS.hb containing 24 static forms and 10 eigenforms 

corresponding to 10 lower eigenfrequencies, mass and stiffness matrices.  

Then run FIDESYS_UM.exe.  

 

2.1.3.4. Data exchange with FIDESYS software 

Run the FIDESYS_UM.EXE converter program to create input.fum file. Select the geome-

try.vtk file in the task directory and specify the save directory for the input.fum file. 
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It's important! Files res.cbm, M_CCS.hb, K_CCS.hb must be located in the same direc-

tory as the geometry.vtk file. Assignment of all fields of the FIDESYS_UM.EXE program 

window is clear by their names (Figure 2.31). 

 

Figure 2.31 

Perform the data conversion with the Create button. If successful, the input.fum file will be 

created in the directory specified in the Directory to save data field.  
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2.1.4. Wizard of flexible subsystems 

Working with the Wizard of flexible subsystems is described in the Sect. 1.2.2. Now you 

should repeat all the instructions from the Sect. 1.2.2. Use the .\platform\input.fum as an input 

file for the Wizard. Please, note, that the .\platform\input.fss file should be created after all. 

2.2. Creating the model and analyzing its dynamics 

Now we will create a new model. From the File menu select New object or click the  

button. 

2.2.1. Introducing elastic platform 

1. Select Subsystems item in the tree of elements. Create a new subsystem by clicking  

button. 

2. Set Type to Linear FEM subsystem. New open dialog appears. In this dialog select the 

.\platform directory. 

You can see elastic modes using the Amplitude and Rate track bars on the Solution | Modes 

tab. 

3. Set Name to Platform (Figure 2.32). 

 

Figure 2.32. 

2.2.2. Attaching the elastic platform to a base 

Platform is attached to a ground with the help of four visco-elastic force elements that are 

situated at the edges of the platform. Firstly we will create graphical objects for force elements 

and then create force elements themselves. 
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2.2.3. Creating graphical elements 

Now we will create graphical object for elastic force elements. 

1. Select Images in the tree of elements. 

2. Add new graphic object (GO) by clicking the  button. 

3. Set name of the new GO to Dampfer (Figure 2.33). 

  

Figure 2.33. 

 

4. Click the  button and select parameters of  Bipolar GO (Figure 2.34) 

 

Figure 2.34 

 

5. Add a new graphic element (GE) by clicking the  at the lower panel (Figure 2.35). 

  

Figure 2.35. 

6. Select Spring type in the pull-down menu (Figure 2.36). 
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Figure 2.36. 

7. Set Spring parameters as in Figure 2.37. 

  

Figure 2.37. 

8. Add a new GE to the GO. Set its type as Cone and parameters as in figure 2.38a. 
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Figure 2.38. а), b) 

9. Add the second GE Cone and set its parameters as in Figure 2.38b. Go to the GE position 

tab of the second GE Cone  (Figure 2.39) and shift the element on 0.015 along Z axis (the 

Translation | z box). 

 

Figure 2.39. 

10. Set the diffuse and specular  components of the Cones color by Diffuse  and Specular but-

ton on the Color tab (Figure 2.40a - first Cone,  Figure 2.40b - second Cone). 
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a                                                    b 

Figure 2.40.  

The images are created. Let us continue with the force elements. 

2.2.4. Force elements 

Let us introduce several identifiers to set the attachment points:  

 BeamLength – the length of platform beams; 

 WidthShelf – the width of connecting shelf; 

 WidthBeamShelfLow – the width of lower shelf of beam section. 

Let us start with the elastic element on the front left end of the platform beam. 

1. Select Linear forces in the object element list. 

2. Add a new force element by clicking the  button. 

3. Rename it as Dampfer_FL (forward, left), set element type Viscous-elastic, interacting 

bodies Base0 Platform.Platform as well as the Spring_Dampfer GO (Figure 2.41). 

4. Set coordinates of element attachment points to the first body Base0: 

BeamLength/2, WidthShelf/2 + WidthBeamShelfLow/2, – 0.05;  

Initialize values of identifiers as (Figure 2.43) 

BeamLength=1.0, WidthShelf=0.4, WidthBeamShelfLow=0.1 

5. Coordinates of the element end point in undeformed state in system of coordinates of the 

first body, Figure 2.41: 

BeamLength/2, WidthShelf/2 WidthBeamShelfLow/2, 0. 
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6. Select Body2 tab. Set coordinates of element attachment points to the second body Plat-

form.Platform (Figure 2.42): 

BeamLength/2, WidthShelf/2 + WidthBeamShelfLow/2, 0; 

 

 

Figure 2.41. 

 

Figure 2.42. 
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Figure 2.43. 

7. Let us introduce a stiffness matrix of the element. Select Parameters tab. Click the  but-

ton in the Stiffness matrix box (Figure 2.44), set diagonal elements of the matrix corre-

sponding to the translational degrees of freedom (Figure 2.45), and click OK. Set the fol-

lowing identifier values: cxx=1e+6, cyy=1e+6, czz=1e+6 (N/m). 

 

Figure 2.44. 

 

Figure 2.45. 

The elastic part of force element is described. 

Now let us describe damping part of the front left element. 

Let us set dissipative matrix of the element. Select Parameters tab (Figure 2.44). Click the 

 button in the  Dissipative matrix box, set the diagonal elements of the matrix corresponding 
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to the translational degrees of freedom dxx, dyy, dzz , and click OK ( Figure 2.46). Set the fol-

lowing identifier values dxx=1E3, dyy=1E3, dzz=1E3 (Ns/m). 

 

 

Figure 2.46 

Damping part of element is described. 

Create the rest three pairs of force element quite similar to the previous ones. Use the  

button to copy the description. Do it in the following manner. 

8. Select previously described element of the necessary type, e.g. Spring_Dampfer_FL in the 

case of a new elastic element. 

9. Click the  button to create a copy. 

10. Rename the copy, e.g. Dampfer_FR (forward, right). 

11. Correct coordinates of attachment points. For the Dampfer_FR element we have Base0: 

BeamLength/2, -WidthShelf/2 - WidthBeamShelfLow/2, –0.05;  

Platform.Platform:  

BeamLength/2, -WidthShelf/2 - WidthBeamShelfLow/2, 0.0;  

Coordinates of the element end point in undeformed state in system of coordinates of the first 

body: 

BeamLength/2, -WidthShelf/2 - WidthBeamShelfLow/2, 0.0 (Figure 2.41). 

Thus, the full list of force elements connecting the platform with the base must include the 

following elements: Dampfer_FL, Dampfer_FR, Dampfer_BL, Dampfer_BR. 
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2.2.5. Model of electric motor 

We shall not create the model but use the ready model of an electric motor located in the 

{UM Data}\SAMPLES\Flex\electricmotor directory. 

2.2.6. Adding motor to object as a subsystem 

1. Select the Subsystems tab in the element list. Add a new subsystem by the  button. 

2. Select its type Included and open the {UM Data}\SAMPLES\ Flex\electricmotor model 

(Figure 2.47). 

 

Figure 2.47. 

3. Rename the subsystem as Electricmotor. 

4. Set the subsystem location as in Figure 2.48. 

../../SAMPLES/Flex/electricmotor
../../SAMPLES/Flex/electricmotor
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Figure 2.48. 
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2.2.6.1. Setting angular velocity of the rotor 

Let us set the law for angular velocity of the rotor as it shown in Figure 2.49. Here we can 

see three modes: speeding up, a working mode and a braking mode. During speeding up and 

braking angular acceleration is constant and angular velocity changes linearly, see Figure 2.49. 

The law from Figure 2.49 is parameterized with the help of six identifiers, see Table 1. 

  

tstart 

omega 

t 

tspeeding_up tworking tbraking 
 

Figure 2.49. Angular velocity of the rotor 

Table 1 

Identifiers 

 Identifier Meaning 

1 Nu Nominal angular velocity of the rotor, revolutions per minute 

(r.p.m.) 

2 omega Nominal angular velocity of the rotor, rad/s 

3 tstart Time before speeding up, s 

4 tspeeding_up Time of speeding up mode, s  

5 tworking Time of working mode, s 

6 tbraking Time of braking mode, s 

1. Click the Edit subsystem button to edit the Electricmotor subsystem, see Figure 2.48. New 

object constructor for the Electricmotor appears. 

2. Select Joints | jRotor->Body in the tree of elements. It is a joint of the Generalized type. 

3. In the Inspector window in the right part select the RTx elementary transformation 

(Figure 2.50.) This time function is set as time-table of 5 rows, see Table 2 and Figure 2.50. 

Table 2 

Time-table for the rotor 

№ Time interval Expression 

1 Tstart 0 

2 tstart+tspeeding_up (omega/tspeeding_up)*sqr(t-tstart)/2 

3 tstart+tspeeding_up+tworking (omega/tspeeding_up)*sqr(tspeeding_up)/2+ ome-

ga*(t-tstart-tspeeding_up) 

4 tstart+tspeeding_up+tworking+ (omega/tspeeding_up)*sqr(tspeeding_up)/2+ ome-
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tbraking ga*tworking+omega*(t-tstart-tspeeding_up-

tworking)-(omega/tbraking)* sqr(t-tstart-

tspeeding_up-tworking)/2 

5 100 (omega/tspeeding_up)*sqr(tspeeding_up)/2+ ome-

ga*tworking+omega*(tworking)-

(omega/tbraking)*sqr(tbraking)/2 

 

Figure 2.50. 

4. Close the constructor window of the Electricmotor and come back to the composite model. 
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2.2.7. Electric motor and platform coupling by force elements 

Coupling the electric motor and the platform can be set quite similar to attaching the platform 

to the base. Electricmotor.Body and Platform.Platform are interacting bodies. An example of 

description of an elastic force element is shown in Figure 2.51. 

  

Figure 2.51. 

Table 3 contains coordinates of attachment points of elastic and damping force elements real-

izing the coupling. 

Table 3. 

Force element Electricmotor.Body Platform.Platform 

X Y Z X Y Z 

DamperMotorFL, 0 0.05 -0.06 0 0.075 0.06 

DamperMotorFR 0 0.05 -0.06 0 -0.075 0.06 

DamperMotorBL -0.0875 0.05 0.0899 -0.0875 0.075 0.06 

DamperMotorBR -0.0875 0.05 0.0899 -0.0875 -0.075 0.06 

 

Coordinates X, Z of the end points of elastic element in undeformed state coincides with 

Electricmotor.Body, Y=0.07. 

Please draw attention to the rotation on -90 degrees about the X axis (Figure 2.51), to make 

the orientation of SC of the force element coinciding with the SC of the Electricmotor.Body. 

Set the stiffness matrices of elastic force element (a) and dissipative matrix of the element (b) 

as it is shown in Figure 2.52. 
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a) 

 
b) 

Figure 2.52. 

Initialize the identifiers as cStifflateral=1.0E6, cStifflongitudinal=1.0E6. The correspond-

ing values for the damping elements are cDisslateral=1.0E3, cDisslongitudinal=1.0E3. 

2.2.8. Preparing for simulation 

1. Save the model as Vibrostand with the help of the main menu or the corresponding button. 

2. Generate and compile equations of motion if equations are generated in symbolic form. 

If no errors detected, the model is ready for simulation. 
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2.2.9. Simulation 

Let us compute the vertical components of forces in force elements coupling the electric mo-

tor and the platform, when the rotor of the motor rotates with the constant angular velocity nu = 

1620 r.p.m. As an example consider the rear right pair of elements. Let us compute displace-

ments and accelerations of a center of plate under the electric motor as well. 

1. Run the UM Simulation with the F9 key or by clicking the  button on the tool panel. 

2. Open a new animation window to visualize the simulation process, 

3. Tools | Animation window…. 

4. Use the Analysis | Simulation… menu command to open the Object simulation inspector. 

5. Use the FEM Subsystems | Image tab of the Object simulation inspector to change the 

flexible platform image if necessary. 
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2.2.9.1. Calculating the equilibrium position and natural frequencies 

Let us calculate the equilibrium position of the stand. 

1. If the Objection simulation inspector is active close it by the Close button. 

2. From the Analysis menu select Static and linear analysis… or press the F8 key. Window 

of linear analysis appears. 

3. Select the Equilibrium tab. Start the calculation by the Run computations button, Fig-

ure 2.53. Calculation process might take some time. 

 

Figure 2.53. 

Now we need to save current coordinates, which correspond to the found equilibrium posi-

tion, to a file of initial conditions.  

4. Select the Initial conditions tab. Click the  button and save current initial conditions to 

the equilibrium.xv file.  

Note. Just found values of coordinates correspond to equilibrium position are correct 

for the current values of identifiers of the model only. Any changes of identifiers 

will lead that found above set of coordinates will not correspond to equilibrium 

position any more. In such a case you need to repeat the calculation of equilibri-

um position. 
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5. Select the Frequencies/Eigenvalues tab. Natural frequencies of the model are calculated 

after selecting button  , Figure 2.54. You can change Amplitude and Rate of the anima-

tion of vibrations. 

 

Figure 2.54. 

6. You can see eigenmodes of the model in the animation window. To see an eigenmode just 

select it in the list and click the Run  button . Now you can see that the animation win-

dow shows any selected eigenmode of the model. For example, animation of second 

eigenmode, 24.0617 Hz  is shown at Figure 2.55. To stop animation click the Stop but-

ton .  
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Figure 2.55. Animation of second eigenmode, 24.0617 Hz 

 

Close the window of Linear analysis. 

 

2.2.9.2. Integration of equations of motion 

1. Open the Wizard of variables (the Tools | Wizard of variables menu command) and cre-

ate variables for Z components of linear force elements DamperMotorBR Figure 2.56. 
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Figure 2.56. 

2. Open a new graphical window (the Tools | Graphical window… menu command).  

3. Drag the created variables into the graphical window by the mouse. 

4. Let us select some node of the FE model where we will calculate Z components of position 

and acceleration. If the animation window does not show nodes of FE mesh, select the FEM 

subsystems | Image. Set Image to full. Turn on the Image | Draw nodes check box. Set 

non-zero value in Node image, for example 3, see Figure 2.57. 
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Figure 2.57. 

Now we will plot oscillograms of a position and acceleration of some arbitrary node of the 

platform. 

5. Select Wizard of variables and create two variables for calculation Z projections of posi-

tion and acceleration of the node 3941 with approximate coordinates (0.05; 0; 0.06), see 

Figure 2.58, Figure 2.59. 

Note. You can plot position and acceleration of any node you want. The only infor-

mation you need is coordinates of the node. To get them point the mouse to the 

node in an animation window and you can see its coordinates in the status bar of 

the window, see Figure 2.58. 

6. Select Wizard of variables and create variable for calculation stress component SX1 of 

node 3941 with approximate coordinates (0.05; 0; 0.06), see Figure 2.60. 

7. Create two new graphical windows (Tools | Graphical window…) and drag and drop just 

created variables to these windows separately. 
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Figure 2.58. 
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Figure 2.59. 
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Figure 2.60. 

 

8. Set the solver parameter on the Solver tab of the inspector as in Figure 2.61: 

 Solver = Park; 

 Type of solving = Range Space Method (RSM); 

 Simulation time = 10.0; 

 Step size = 0.002; 

 Error tolerance = 1E-8; 

 Computing Jacobian Matrices = ON (always for flexible subsystems); 

 Block-diagonal matrices = OFF. 
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Figure 2.61. 

9. On the FEM subsystems | Simulation tab switches gravity, internal dissipation as well as 

linear model should be ON. Set a=0.001, b=0 (Figure 2.62). 
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Figure 2.62. 

10. Select the Identifiers tab in the Object simulation inspector. Select the Vi-

brostand.Electricmotor from the pull-down list of subsystems. Set the following values 

(Figure 2.63): 

 nu=1620 (27 revolutions per second); 

 tstart=0.5; 

 tspeeding_up=2; 

 tworking=3; 
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 tbraking=4. 

Note. Rotational speed of the rotor exceeds two first natural frequencies of the vi-

brostand that is why there will be resonance conditions during speeding-up the 

rotor. 

 

Figure 2.63. 

11. Start the simulation process by the Integration button on the bottom part of the inspector.  

Figure 2.64 depicts some simulation results. 
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Figure 2.64. 

To estimate the influence of the platform flexibility, the following operations could be done. 

12. The option switch off all flexible modes should be on (Figure 2.62). 

13. Run simulation. 

14. Copy variables in graphical windows as static using popup menus (contact menu in a graph-

ical window, Copy as static variables menu item). 

15. Change the option switch of all flexible modes to off (Figure 2.62). 

16. Repeat the simulation. 

17. Compare simulation results. 


